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Configuration Management Tool

In addition to its other features, Statemate provides built-in “checkin-checkout” capabilities similar
to those found in products designed specifically for the task of configuration management
(sometimes called change management, revision management, source control, and so forth).

Previously, Statemate used only its own Configuration Management (CM) tool. Now, you can
transparently substitute the revision engine and repository format of a third-party configuration
management tool for those of Statemate’s built-in facility. Add-on interface modules are
available for the following widely-used CM tools:

Interface modules are available for the following widely-used, third-party configuration
management tools. The following lists the supported CM tools and platforms:

¢ Continuus Software Corp.’s Continuus/CM
¢ Intersolv’s PVCS Version Manager
¢ Rational Software® ClearCase®

Note

To use ClearCase as the CM tool, install Rational Clear Case and set it as the Source Code
Control (SCC) provider.

Set STM_SCC_CLEARCASE environment variable, and when creating a project, select
SCC in the CM Tool field.

On Windows, third-party tools are supported by Source Code Control (SCC), a common interface
introduced by Microsoft.

If you want Statemate to work with a different CM tool, an add-on module is available that allows
you to create a script-based interface to your CM tool of choice.
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Configuration Management Tool

Note

¢ When using Statemate’s interface to a third-party CM tool, you cannot use the tool’s own
user interface to modify or delete Statemate project files. You cannot use the third-party
CM tool to check in or check out files from a repository used to hold a Statemate project.
You can, however, use the tool’s own user interface for read-only operations such as
viewing, searching, and reporting.

¢ Statemate does not support checking out different revisions of the same file. Only one
revision can be checked out at a time.

Statemate’s CM Interface

Regardless of which CM engine and repository you use, the configuration management operations
in Statemate’s user interface remain almost exactly the same. The intent is to make the underlying
mechanism as transparent to your project members as possible.

Note

Only few operations are supported by Statemate, which is not intended to serve as a full user
interface for any third-party CM tool. Many operations available in third-party tools, such as
comparing or merging versions, cannot be performed within Statemate.

The remainder of this section provides a brief overview of the user interface to Statemate’s built-in

configuration management tool. Subsequent sections describe how to replace the built-in facility
with third-party tools.

The Project Databank

Each Statemate project has a common repository area called the databank, which contains the
charts and files belonging to the entire project. When a new project is created, the databank can be
placed in any directory to which the project manager has read and write access. Many sites
designate a special location for project databanks; check with your system administrator.
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Statemate’s CM Interface

Configuration Items

Elements stored in the databank are called configuration items and are stored as ASCI| files. For
example, configuration items are:

+ Charts - Statecharts, Activity charts, Flowcharts, Use Case Diagrams, Sequence Diagrams,
Module Charts, Continuous Diagrams, and Global Definition Sets (GDSs)

*  Analysis profiles

¢ Simulation Control Language (SCL) files

*  Waveform profiles

+  Status files

¢ Check Model profiles

¢ Code generation profiles

¢+ Documentor (DGL) templates

¢ Include files

+ Configuration files

+ Panels

¢ Components

* Targets and Cards

Locking

Statemate uses the standard “lock” paradigm to prevent configuration items from being modified
by more than one person at any time. When checking an item out, the following occurs:

¢ The project member can optionally lock the item, preventing anyone else from modifying
it. Other project members continue to have read access to the item but they cannot lock it.

* A copy of the item is created in the project member’s designated disk space, which is
called a workarea. Any project member can modify a copy of an item in their workarea,
but only the project member who holds the lock on the item can check it in.

When checking an item in, the following occurs:
¢ The project member can choose to retain or release the lock. Until the lock is released, no

one else can modify the item. When more than one project member needs to modify an
item, it is important to unlock the item.

¢ The project member can choose to save or delete the copy of the item in the workarea.

Statemate 3
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Version Numbers

Each configuration item has a version number. Typically, the highest version number represents
the current working design. Lower version numbers represent earlier designs. Each time a project
member checks an item in, Statemate assigns it a version number by incrementing the highest
existing version number.

Statemate’s built-in CM tool tracks versions using whole numbers (positive integers). When you
create a new item and check it into the databank, Statemate assigns it a version number of “1”. If a
third-party CM tool uses a different system of version numbering, the version numbers displayed
by Statemate conform to the format of the third-party tool.

Protection Levels and Groups

The databank directory structure is created with “world read/write,” permissions but specific items
within the structure can be protected differently. You can assign one of the following protection
levels (common to most operating systems) to configuration items in the databank:

+ None - The item cannot be checked out.

¢ Read-Only - The item can be checked out without a lock and used or modified, but cannot
be checked in.

¢ Read-Write - The item can be checked out with a lock (guarantees that other users cannot
change it while you are working on it) and checked in.

You can assign a protection level to the following groups:

¢ Owner - The project member who first created the configuration item in the databank.

¢ Group - Project members who belong to the same group as the owner (according to the
definitions set by the operating system).

¢ Others - All project members.
All versions of a configuration item belong to the same owner and have the same protection level.
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The Databank

The Databank

The Databank allows you to graphically navigate through the information in your databank.

Starting and Using the Databank

In the main project window, click the DataBank tab. The Databank main window opens. Select
View > Filter to choose the types of charts and files you want to be listed in the Databank main
window and click OK.

Databank Main Window

The Databank main window displays a list of the configuration items in the databank, along with
information about the selected item.

i x|

File Edit WYiew Project Configuration Tools Utilities Mindow Help
|® 24 2R & X (BB BB | i |G/ %986 m6
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| [ATAEANK_TEST Activity-chart  LUpdate : :
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(152583 Found 5 elements J
i
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T
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Configuration Item List
The Configuration Item List displays a list of the configuration items in the databank, as specified
in the Show Files dialog:
+ The Name of the configuration item.
+ The Type of item (Statechart, Activity-chart, Configuration file, and so forth).

* The Access (protection level) consisting of one of the following values: none, read,
update.

* Locked by (the name of the person who checked it out).

+ The number of the Last Version to be checked in (a designation of . r indicates that the
version is part of a release).

+ Last Modified is the date the file was checked into the DataBank.
+ The Selected Version on which various operations can be performed.

Item Properties
Double-click on a single configuration item and the Selected Item Information shows more
detailed information, including a list of all existing versions.
* The name of the Owner of the item.
+ Whom, if anyone, the item is Locked by (the name of the person who checked it out).
+ The name of the Workarea containing the item.
+ The Permissions (access) available to the Owner, the project group, and all others.

x
Ouwner: ehopkins Wersionz ]

Locked by: ehopkins 1

in Morkarea: Cihstm_projectz_efhyrear_defog_efh2,uwa

Permissions
IVDL\JHEI"‘: Update Group:  Update Otherz; Read
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The Workarea

Existing Version List

In the Existing Version List, you can select a specific version (or versions) on which to apply
Configuration menu operations.

The Workarea

The Workarea allows you to graphically navigate through the information in your workarea. In the
main project window, select the Charts tab. The Workarea main window appears.

In the upper area, the main window displays all the charts in your workarea arranged in a
hierarchical tree, making it easy for you to see their relationships.

Select the Files tab and the main window displays a list of the charts and other configurable items
in your workarea, along with information about them, such as type and the checked-out version’s
mode, number, and modification status.

In update mode, all editing, viewing, and tool launch features are active (shown in the following
figure). In read-only mode, all viewing and tool launch features are active. The editing features
and drawing icons are disabled.

BT
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Configuration Management Operations

Most of Statemate’s Configuration Management operations are common to both the Databank and
the Workarea. For example, you can check items out from either the Databank or the workarea.
Some operations, however, are unique to one or the other. For example, you only can check items
in using the Workarea.

The following table show the configuration operations that can be performed in the databank and
the workarea.

Menu Operation Databank Workarea Description

Check In to Databank | No Yes Saves the current version of the selected
configurable items in the databank and
updates their current revision numbers.

Options are:
* Hold & Keep Lock
* Hold & Release Lock
¢ Check in & Delete

Check In to Databank | No Yes Saves the current version of the selected
with Descendants configurable items and descendants in the
databank and updates their current
revision numbers.

Options are:
* Hold & Keep Lock
* Hold & Release Lock
* Check in & Delete

Check Out Yes Yes Copies and locks (if ‘with lock’ is selected)
Check Out Chart/File files/charts from the databank to your
workarea (update mode).

Options are:
« With Lock
» Without Lock

Check Out With Yes Yes Copies and locks (if ‘with lock’ is selected)
Descendants files/charts and descendants from the
databank to your workarea (update mode).

Options are:
* With Lock
¢ Without Lock

Update Workarea No Yes Opens Update Workarea dialog box.
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Configuration Management Operations

Menu Operation Databank Workarea Description
Advanced Update No Yes Options are:
Workarea « Remove Unused Elements
* Filtered Check Out from Databank of
Selected
* Filtered Check Out from Databank of
All
* Filtered Check Out of GDSs of
Selected Charts
* Filtered Check Out Parent from
Databank
Check Out Parent Yes Yes Copies parent charts from the databank to
from Databank your workarea
Release Lock Yes Yes Unlocks files/charts in the databank that
currently exist in your workarea (set read-
only mode).
Release Lock Yes No Notifies you when a lock, set by another
Notification user on a chartffile, is released
Lock Yes No Locks files/charts in the databank that
currently exist in your workarea (sets
update mode).
Purge Yes No Deletes older versions of files/charts in the
databank that you own.
Delete Yes No Deletes files/charts in the databank that
you own.
Create Configuration | No Yes Opens the Create Configuration dialog
box.
Execute Yes Yes Checks-out all chartsffiles in the
Configuration configuration file into the workarea.
Create/Modify No Yes Allows you to set up a component from a
Component selected generic chart or an existing
component.
Remove Component | No Yes Allows you to remove a component from
the workarea.
Component Versions | Yes Yes Displays the versions of a component

configuration file.

Statemate
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Using Configuration Management

A Configuration file is a “snapshot” of the current workarea, including all configuration item
versions. Configuration files are used primarily for capturing milestones or releases of a project.
Other users can execute a Configuration file to load the same items (and versions) that you have in
your workarea.

Configuration files are also useful when you upgrade to a new major Statemate release.

Menu L
; Databank | Workarea Description
Operation

Create _ No Yes Creates a Configuration file that captures the

Configuration current workarea. You can include all files or only
selected files.
At the same time, you can check in the new
Configuration file and/or the files that are in the
configuration itself.

Execute Yes Yes Selects a previously created Configuration file and

Configuration loads charts/files into your workarea. The
Configuration file must exist in the workarea. If it
does not, check the Configuration file out of the
databank.

Selecting a CM Tool for a Statemate Project

The decision to use Statemate’s built-in facility or a third-party configuration management tool
must be made when you create a Statemate project. You cannot change the CM tool used by an
existing project. You can, however, create a new project from an existing project by importing all
the objects.

The File > New Project dialog box contains a control named CM tool, as shown in the following
figure. Select an available tool from the CM Tool pull-down menu, as shown in the following
figure.
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Selecting a CM Tool for a Statemate Project

Create New Projeck

ehepkine 3]
Ci™ | e

HATNLODP_SC

You can specify the CM tool used by default for new projects in the Project > General
Preferences dialog box.
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Defining Third-Party CM Tool Interfaces

In addition to supported interface modules for certain widely-used CM tools, modules are
available that allow you to define interfaces to other CM tools. This section explains how to
define a new Statemate interface to any third-party CM tool.

Note

When using Statemate’s interface to a third-party CM tool, you cannot use the tool’s own
user interface to modify or delete Statemate project files. You cannot use the third-party CM
tool to check in or check out files from a repository used to hold a Statemate project. You
can use the tool’s own user interface for read-only operations such as viewing, searching,
and reporting.

Script-Based Interface to CM Tools

When using a third-party tool, the CM operations available in Statemate’s Databank and Workarea
are carried out by external executable files. Statemate itself does not directly communicate with
your CM tool. Instead, it provides a generic CM interface. You provide the files that map each
operation in Statemate’s generic interface to some specific CM tool. For convenience, these files
are referred to simply as scripts in this section. Statemate provides a sample implementation that
you can copy.

The flow of information between Statemate, the scripts, and the CM tool is shown in the following
figure:
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Defining Third-Party CM Tool Interfaces

Parameters

Statemate Script

Status Commands

and Data and
Parameters

CM Tool

Since Statemate simply issues requests to the operating system to execute files, these scripts can be
implemented using whatever programming resources are available to you. For example, you can
use the following:

+  Scripts, written in an interpreted language such as Perl or C shell, that communicate with
your CM tool through its command line interface.

+ Programs, written in a compiled language such as C or C++, that communicate with your
CM tool through its application programming interface.

You must provide a script for each of the CM operations described in this section. You can name
them and place them anywhere. However, you must also provide a file that maps Statemate’s CM
operations to your scripts, as explained in the sections that follow.

14
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Script-Based Interface to CM Tools

How Statemate Determines Available CM Tools

In Statemate dialog boxes, the list of CM tools available is composed of:

¢ STM, the built-in facility, which is always available.
+ Any other CM tool for which there is a mapping file.
A mapping file is a text file named:

$STM_ROOT/etc/cmt/cm_tool name.cmt
Replace cm_tool name with your own CM tool’s name. For example, if the directory sstv_rooT/
etc/cmt/ contains the following mapping files:

cm_toolA.cmt
cm_toolB.cmt

cm_toolC.cmt

In Statemate dialog boxes, the CM Tool control shows the following tools

Statemate

cm_toolA

cm_toolB

cm_toolC

To add another CM tool to the list, simply create a new cm_tool name.cmt file by copying
the template file cm.cmt_template.
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Mapping Individual CM Operations to Scripts

The mapping file cm_tool name.cmt is a text file that maps each CM operation in Statemate to a
script that actually performs the operation. The contents of the mapping file template are shown in
the following table:

CM_USER_FUNC_init

path_of_scripts/init

CM_USER_FUNC_get_Tfile

path_of _scripts/get_file

CM_USER_FUNC_put_file

path_of_scripts/put_file

CM_USER_FUNC_is_file_in_bank

path_of_scripts/is_file_in_bank

CM_USER_FUNC_is_locked_in_bank

path_of_scripts/is_locked_in_bank

CM_USER_FUNC_get_ver_from_bank

path_of_scripts/get_ver_from_bank

CM_USER_FUNC unlock_file

path_of_scripts/unlock_file

CM_USER_FUNC_lock_file

path_of _scripts/lock File

CM_USER_FUNC_delete_from_bank

path_of_scripts/delete_from_bank

CM_USER_FUNC_delete_revision

path_of_scripts/delete_revision

CM_USER_FUNC_calc_archive_name

path_of_scripts/calc_archive_name

CM_USER_FUNC_get_pattern

path_of_scripts/get_pattern

CM_USER_FUNC_get_locked_by

path_of_scripts/get_locked_by

CM_USER_FUNC_get_versions

path_of_scripts/get_versions

CM_USER_FUNC_modify_to_archive

path_of_scripts/modify_to_archive

Note

The list of operations in this file is defined by Statemate. You cannot add or remove
operations.

To define a new interface for a CM tool, edit the new mapping file and replace the string
path_of scripts With the actual path of the directory that contains the scripts for your CM tool.
It is recommended that you do not change the names of the scripts. Creating the scripts is
described in the next section.
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Script-Based Interface to CM Tools

Creating CM Operation Scripts

As stated previously, the scripts that implement individual CM operations can be:
+ Shell scripts or Perl scripts that communicate with the CM tool via its command line
interface.

+ Executable programs that communicate with the CM tool via its application programming
interface.

+ Any other implementation method available to you.

When Statemate issues a request to the operating system to execute a specific script, it passes
parameters containing the information needed to perform the task. The script reads the parameters
from the argument vector. For example, this Perl statement stores the parameters in a list variable:

#!/usr/bin/perl -w

(sworking dir, $bank dir, $tmp result file) = @ARGV;

It is recommended that you write the parameters to the standard output to assist in debugging. For

example:
Sfunc = "init";
$echo = "$func : $working dir,

S$bank dir, $tmp result file\n";

print Secho;

Then, the script calls the CM tool to perform the operation.

When the CM tool finishes, the script returns the result of the CM tool operation (and in some

cases data) to Statemate by creating a temporary file. Statemate deletes the temporary file after
reading it.
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Parameter Types

The following table defines the set of parameter types used by Statemate to communicate with

scripts
Parameter Description
bank_dir Full pathname of the databank directory.
ext Extension of the configuration item in the Workarea.

full_archive_name

Full pathname of the archive file of the configuration item in the
databank.

lock lock state: 1 for “with lock”, O for “without lock”.

name Name of the configuration item in workarea (without extension).
ret_val Status: 1 for success, 0 for failure.

revision Version number in the CM tool’s own format.

temp_result_file

The name of a temporary file in which Statemate expects the script to
return its results; Statemate deletes this file after reading it.

tmp_file_to_ci

Temporary file of chart to be checked in.

workarea_dir

Full pathname of the workarea.

workfile_name

Name of the configuration item in the workarea (including extension).

working_dir

Full pathname of the of the working directory within the workarea.

The following sections describe the specific scripts and input/output parameters.

18
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CM Script Reference

CM Script Reference

This section provides examples in the form of Perl scripts for an interface to RCS, the UNIX
Revision Control System.

calc_archive_name

Description:
Composes the full archive name of a configuration item.
Syntax:

CM_USER FUNC calc archive name

input bank_dir

name

ext
temp_result_file

output | ret_val
full_archive_name

delete_from_bank
Description:
Deletes an archive file from the databank.
Syntax:

CM_USER _FUNC delete from bank

input bank_dir

name

ext
full_archive_name
temp_result_file

output | ret_val
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delete_revision

Description:

Deletes a specified revision of an archive file in the databank.

Syntax:

CM_USER FUNC delete revision

input bank_dir
name
ext
full_archive_name
revision
temp_result_file

output ret_val

get_file
Description:
Checks out a file from the archive.
Syntax:
CM_USER_FUNC_get file

input working_dir
workfile_name
full_archive_name
revision
lock
temp_result_file

output ret_val
revision
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Example:

#!/usr/bin/perl -w

#initialize variables

(sworking dir , $workfile name , $full archive name , S$revision ,

$lock ,$tmp result file) = @ARGV;
#echo command

$func = "get file";

$echo = "$func : $working dir , sworkfile name ,

Srevision , $lock , Stmp result file\n";
print Secho;
#update result file

open (RESULT FILE , "> $tmp result file");

if (Slock == 0)

{

‘cd $working dir ; co $full archive name‘;

}

else

{

‘cd $working dir ; co -1 $full archive name‘;

}

print RESULT FILE "1\n";

$full archive name ,

$str = ‘cd $working dir ; rlog $full archive name | grep head‘;

Sout_ver = substr($str,10,100);

print RESULT FILE "$Sout ver\n";

Statemate
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Defining Third-Party CM Tool Interfaces

get _locked by

Description:

Returns the name of the user who locked an archive file.

Syntax:

CM_USER_ FUNC get locked by

input full_archive_name
temp_result_file
output | ret_val
locked_by
get_pattern
Description:

Returns a pattern that can be used to search the databank for archive files of a specific type.

Syntax:
CM_USER_FUNC get pattern
input ext

temp_result_file
output | ret_val pattern

Example:
Type of File Pattern
Statechart Description ~ .M\ .sch\\.desc$
ClearCase Statechart Archive ~.*\\.sch$
RCS Statechart Archive ~N.*\\.sch,Vv\$

22
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get_ver_from_bank
Description:
Gets the top revision of the file in the databank.
Syntax:
CM_USER_FUNC get ver from bank
input bank_dir
name
ext

full_archive_name
temp_result_file

output | ret_val
revision

get _versions
Description:
Returns a list of versions of an archive file (in CM tool format).

Syntax:

CM_USER_FUNC_get_ versions

input full_archive_name
temp_result_file
output | ret_val

[oldest_revision ...] newest_revision

Statemate 23



Defining Third-Party CM Tool Interfaces

init

Description:

Initiates the CM tool.

Syntax:

CM_USER_FUNC_ini

t

input workarea_dir
bank_dir
temp_result_file

output ret_val

Example:

#!/usr/bin/perl
#initialize vari
(sworking dir ,
#echo command
sfunc = "init";

Secho

"$func

print Secho;

-w
ables

Sbank dir , $tmp_ result file) = @ARGV;

Sworking dir , $bank dir , Stmp result file\n";

#perform operation

#update result £

open (RESULT FILE

ile

"> $tmp result file");

print RESULT FILE "1\n";
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is_file_in_bank
Description:
Checks whether or not a file exists in the databank (has been checked in before).

Syntax:

CM_USER FUNC is file in bank

input full_archive_name
temp_result_file

output | ret_val

iIs_locked_in_bank
Description:

Checks whether or not a file in the databank is locked (was checked out with lock).

Syntax:

CM_USER_FUNC_is_locked_in_bank

input full_archive_name
temp_result_file

output | ret_val

lock_file

Description:

Executes the lock command on the file in the databank.

Syntax:

CM_USER_FUNC_lock file

input bank_dir
name ext
full_archive_name
temp_result_file

output | ret_val
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modify_to_archive
Description:

Converts a file name into an archive full path name (similar to calc_archive name).

Syntax:

CM_USER FUNC modify to archive

input file_name
temp_result_file
output | ret_val
archive_file_name
put_file
Description:

Checks in a file to the archive.
Syntax:

CM_USER _FUNC_put file

input working_dir
workfile_name
tmp_file_to_ci
ext
temp_result_file

output | ret_val
revision
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unlock_file

Description:

Executes the unlock command on a file in the databank.

Syntax:

CM_USER FUNC unlock file

input bank_dir

name

ext
full_archive_name
temp_result_file

output | ret_val

Statemate
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User Function Interface to CM Tool

There is an API in the Statemate CM DLL called stTM_cm_init_item. This API is called by the

tool on any CM item, before any other call is done on this item, and only once per configuration
item per session.

This API is optional. The tool calls it only if it is implemented in the specific DLL used.

Define the Dynamic-Library path name in the cm_tool name.cmt file located in the directory
$$STM-ROOT/etc/cmt /. FOr example:

DLL-NAME /root31/bin/stm _cm user.dll

Note

The DLL path name should be all lowercase.

API functions (see stm cn user,h)
#define STM_CM_success 0
#define STM _CM message_ length 1024
#define STM CM_archive name length 2048
#define STM_CM_version_length 80
#define STM_CM_user_name_length 512

When the return value of a certain API is of type “int”, the following convention holds:

¢ “0” (zero) marks success
¢ Anything but “0” is regarded as error-code
Memory management is done independently between STMM and the dynamic-library:

*  When STMM calls a certain API with parameters defined as “const char *”, the intention
is that those are managed by STMM and should be regarded as read-only variables.

¢ When STMM calls a certain API with parameters defined as “char [length]” (with length
being either 512 or 1024), the intention is for the API to use the parameters as error
messages and returned information.

¢+  When STMM calls a certain API with parameters defined as “char * []” (as in 2.n, 2.p), the
intention is that those are managed by the dynamic-library. STMM copies the content as
soon as the API returns. It is recommended to use static buffers in the dynamic-library
implementation for those parameters.
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For building the DLL, you can use stm_cm_user.def file:

LIBRARY

stm_cm_user

EXPORTS

The following sections describe the user functions:

*

ST™M
ST™M

CM
CM

init

calc_archive_name

ST™M

CM

get_files_list

ST™M

CM

put_file

ST™M

CM

is_locked_in_bank

ST™M

CM

is_file_in_bank

ST™M

CM

unlock_file

ST™M

CM

lock_file

ST™M

CM

standalone_lock_file

ST™M

CM

get_ver_from_bank

ST™M

CM

get_versions

ST™M

CM

get locked by

ST™M

CM

delete_from_bank

ST™M

CM

delete_revision

ST™M

CM

modify_to_archive

ST™M

CM

aet_pattern

ST™M

CM

get_files_list

ST™M

CM

rollback

ST™M

CM

get_file_last modified_date

ST™M

CM

init_item

ST™M
ST™M

CM
CM

close

begin_databank_operation

ST™M

CM

end_databank_operation

Statemate
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STM_CM_begin_databank _operation
Description:
Starts the databank operation.

Syntax:

int
STM_CM_begin_databank_operations (
char error messages[STM_CM message length])

STM_CM calc_archive_name
Description:
Composes the full archive name of a configuration item.

Syntax:

STM CM_calc_archive name

input bank_dir
name
ext

output

int
STM_CM_calc_archive name (
const char * bank dir,
const char *name,
const char *ext,
char full archive name [STM _CM_archive name lengthl],
char error message[STM CM message length]

)i

STM_CM close

Description:
Closes the databank.
Syntax:
int
STM _CM_close (

char error_message [STM_CM_message_length
)i
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STM_CM_delete_from_bank
Description:
Deletes an archive file from the databank.
Syntax:
STM CM_delete from bank

Input bank_dir
name

Output |

int

STM _CM-delete from bank (

const char *bank dir,

const char *name,

const char *ext,

const char *full_archive name,

char error message[STM CM message length]
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STM_CM_delete_revision

Description:

Deletes a specified revision of an archive file in the databank.

Syntax:

STM CM_delete revision

Input

bank_dir

name
ext

full_archive_name
revision

Output

int

STM CM delete revision(

const
const
const
const
const

)i

char error

char
char
char
char
char

*bank dir,

*name,

*ext,

*full archive name,
*revision,

_message [STM_CM message length]

STM_CM_end_databank_operation

Description:

Ends the databank operation.

Syntax:

int

STM _CM_end_databank operation(

)i

char error message [STM_CM message length]
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STM_CM_get file

Description

Checks out a file from the archive.

Syntax:

STM CM get file

Input

working_dir
workfile_name
full_archive_name
user_name

revision

Output

int

STM_CM get file(

const
const
const
const
const

char
char
char
char
char

int lock,
char out_revision[STM_CM_version_length],
char error message[STM CM message length]

* working dir,
*workfile name,
*full archive name,
*user name’
*revision,

Statemate
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STM_CM _get files_list
Description:

This function returns the 1ist_of files iNto the bank_dir. The size of the
list_of files IS then written in the number of files.

If there are more than the number of files files in the bank dir, a fail status is returned, and
the number of files is changed to contain the actual number of files in the bank _dir. A
second call to the API is than performed with the actual size for the 1ist_of files.

Syntax:

int

STM_CM_get_files_list(
const char *bank dir,
const char *pattern,
int *number of files,
char *list _of filesl|],
char error message[1024])

) i
Note

Do NOT allow your code to write more than the given number of files into the
list of files parameter, or it will cause memory access violations.

STM_CM_get _file_last_modified_date
Description:
Retrieve the last modification date of chart/file

Syntax:

int
STCM_CM get file last modified date(
const char *full archive name,
char last modified date info[STM_CM version_ length],
long *date num info,
char error meassage [STM_CM message_length]

34 Configuration Management



User Function Interface to CM Tool

STM_CM_get_locked_by
Description:
Returns the name of the user who locked an archive file.
Syntax:
STM CM get locked by

Input full_archive_name
revision

Output |

int
STM_CM_gte locked by (
const char *full archive name,
const char *revision,
char locked by[STM CM user name_ length],
char error message[STM CM message_ length]
)i

STM_CM get_pattern

Description:

Returns a pattern that can be used to search the databank for archive files of a specific type.

Syntax:

STM_CM_get pattern

Input |ext
Output |

int

STM_CM get pattern(
const char *ext,
char pattern [STM_CM message_length],
char error message[STM CM message length]

)i

Statemate
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STM_CM_get _ver _from_bank

Description:
Gets the top revision of the file in the databank.
Syntax:

STM_CM get ver from bank

Input bank_dir
name
ext
full_archive_name

Output

int
STM CM_get ver from bank(
const char * bank dir,
const char *name,
const char *ext,
const char *full archive name,
char revision[STM_CM version length],
char error message[STM CM message length]
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STM_CM_get_versions
Description:
Returns a list of versions of an archive file (in CM tool format).

Syntax:

STM _CM_get versions

Input full_archive_name
number_of versions
versions

Output

int
STM_CM_get_version (
const char *full archive name,
const char *number of versions,
const char *versions|[],
char error message[STM CM message_ length]
)i

Note

When the API is called, the number of versions parameter specifies the number of
possible entries in the versions parameter. The API is expected to set this parameter to the
actual number of revisions. If this number is more than the number of possible entries in the
versions parameter, the API is called again with the appropriate number of possible
entries. If more entries are needed, the function teturns a “fail” status. You cannot specify
more than the given number of versions Vvalue in the versions parameter because it
causes memory access violations.
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STM_CM _init
Description:
Initiates the CM tool.
Syntax:
STM CM_init

Input workarea_dir
bank_dir

Output |

int
STM_CM_init(
const char *workarea dir,
const char * bank dir,
char error message[STM CM message length]

)i

STM_CM _init_item
Description:

The CM DLL calls this API before any other call is sent to an Item. This occurs once per
configuration item per session. This API is optional in that the tool calls it only if it is
implemented in the specific DLL used.

Syntax:

int
STM_CM_init_item(

const char *bank dir,

const char *name,

const char *ext,

char error message[STM CM message_ length]
)i
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STM_CM s _file_in_bank
Description:
Checks whether or not a file exists in the databank (has been checked in before).
Syntax:
STM CM is file in bank
Input full_archive_name

is_in_bank
Output |

int
STM_CM_is_file_in_bank(
const char *full archive name,
int * is_in_bank,
char error message[STM CM message length]

)i

STM_CM is_locked in_bank
Description:
Checks whether or not a file in the databank is locked (was checked out with lock).

Syntax:

STM CM_is_ locked in bank

Input full_archive_name
revision
is_locked
int

STM CM_is locked in bank(
const char *full_ archive name,
const char *revision,
int *is_locked
char error message[STM CM message length]
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STM_CM lock file

Description

Executes the lock command on the file in the databank

Syntax:

STM CM lock file

Input

bank_dir

name
ext

full_archive
user_name

version

int

STM_CM_ lock file(

const
const
const
const
const
const

char
char
char
char
char
char

*bank dir,

*name,

*ext,

*full archive name,
*user name,
*yversion

int in load op,

char error message [STMCM message length]
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STM_CM_modify to_archive

Description:

Converts a file name into an archive full path name (similar to calc_archive name)

Syntax:

STM CM _modify to archive

Input |fi|e_name
Output |

int

STM-CM_modify to_archive
const char *file name,
char out_file name[STM CM_archive name lengthl],
char error message[STM CM message length]

)i

Statemate 41



Defining Third-Party CM Tool Interfaces

STM_CM_put_file
Description:
Checks in a file to the archive.
Syntax:
STM CM put_ file
Input bank_dir

workfile_name
temp_file_to_ci

ext
user_name
comment_str
keep_lock
Output
int

STM_CM_put_file(
const char *bank dir,
const char *workfile name,
const char *temp file to ci,
const char *ext,
const char *user name,
const char *comment_ str,
int keep lock,
char revision[STM_CM version length],
char error message[STM CM message length]
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STM_CM rollback

Description:

This APl is an alternative to STM_CM _unlock_file. It executes the unlock command on a file
in the databank. The API is called only if the CM DLL does not include implementation for
STM_CM_unlock_file. In case that the sTM_cM unlock_file is not implemented, the
“Unlock” menu entry in the Statemate Configuration menus are visible to the user.

This API is optional and may not be implemented in the DLL.

Syntax:

STM_CM_rollback

Input

bank_dir

name

text
full_archive_name
user_name
version

Output

int

STM_CM_rollback (

const
const
const
const
const
const

char *bank dir,

char *name,

char *ext,

char *full_archive_name,

char *user name,

char [STM_CM version_ length],

char error message[STM CM message length]
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STM_CM_standalone_lock_file

Description:

Syntax:

int
STM_CM_standalone_lock file(
const char *bank dir,
const char *name,
const char *ext,
const char *full_ archive_ name;
const char *user_ name,
const char *version,
int in load op,
char error_message [STM_CM_message_length]
)i

STM_CM _unlock_file

Description:

Executes the unlock command on a file in the databank.

Syntax:

STM_CM_unlock_file

Input bank_dir

name

text
full_archive_name
user_name
version

int
STM_CM_unlock_file(
const char *bank dir,
const char *name,
const char *text,
const char *full archive name,
const char *user name,
const char *version,
char error message[STM CM message length]
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Information Specific to PVCS

This provides restrictions and branching information specific to the PVCS interface module.

Restrictions

The following restrictions apply when using the PVCS interface module:
+ PVCS does not control the workarea into which a file is placed when it is locked.

+ PVCS “group” information has no meaning in the context of Statemate; therefore the

access and permission fields in the Databank form also have no meaning when PVCS is
used.

Branching

After checking out a configuration item with locking, the next check in puts the new revision as the

next revision after the locked revision, rather than after the highest numbered revision. For
example, take an item with three revisions:

Checking out revision 1.1 and then checking it in creates revision 1.1.1.0, a branch.
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Checking out 1.1.1.0 and checking it in creates revision 1.1.1.1., then 1.1.1.2 and so forth.

Checking out 1.1.1.0 again and checking in creates another new branch 1.1.2.0.

To return to the main branch, complete the following steps:
1. Release the lock.
2. Relock the item.

3. This locks the last revision on the main branch so the next check in is on the main branch.
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